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Introduction and Overview

Welcome to TeachUcomp, Inc.’s Mastering Excel Made 

Easy  tutorial. This tutorial introduces the student to 

Microsoft Excel, one of the most popular spreadsheet 

programs. This tutorial gives the student with little or no 

knowledge of Excel a firm skills base using Excel. 

 Excel is an excellent program to learn, as the skills you 

learn also apply to many other programs. Understanding 

Excel is helpful before learning about more complicated 

data-storage and manipulation programs, like Access or 

other relational database software. 

 Excel is a multi-featured spreadsheet software in which 

you create powerful worksheets that manipulate numbers 

in columns and rows for you. It is a very powerful program 

and has many advanced features that can automate and 

simplify your work. Whether you want it to create charts, 

worksheets, or data sources, Excel can help you 

accomplish your tasks quickly and easily.

 This tutorial starts by teaching the student basic Excel 

skills like creating and formatting worksheets and inserting 

formulas. It then teaches the student enhanced skills like 

creating and formatting charts, using more advanced data 

tools, and creating tables. Finally, the student learns 

advanced Excel skills like creating and managing data 

models, using PivotTables and PivotCharts, and much 

more!
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Getting Acquainted with Excel

1.1- About Excel:

 Microsoft Excel is a spreadsheet program you use to organize and manipulate information. With 

Excel, you can create worksheets that can instantly perform complex calculations. When the numbers in a 

worksheet change, Excel recalculates the answers automatically! You also have complete control over the 

appearance of worksheets. For example, you can control the size, style, and color of the font used in the 

worksheets.

 Excel can also create charts, tables, and graphs from data stored in its worksheets. It can also use 

data stored in other applications. For example, you could import data from an Access table into your 

worksheet and then create a report with an accompanying chart to illustrate the data in Excel. You could 

then perform additional mathematical operations on the data in Excel, if desired. For example, projecting 

fiscal scenarios is one way to take advantage of the tools available in Excel.

 Excel contains many tools that help you perfect your worksheets. The “AutoSum” tool is an excellent 

example of this ingenuity of design. The AutoSum tool automatically adds numbers in columns and rows for 

you.

 Students new to Excel should first take a moment to familiarize themselves with Excel’s general 

operating environment. To become a fast and efficient Excel user, you should first know where to find the 

tools in the program’s interface. You should also know the names of these tools.
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Getting Acquainted with Excel

1.2- The Excel Environment:

 The picture below shows the user interface in Excel for Microsoft 365 after creating a new, blank 

workbook. A workbook is the default file type in Excel, much like a document is the default file type in Word. 

A workbook can contain multiple worksheets that store and manipulate data in their columns and rows. By 

default, Excel gives you one worksheet in a new, blank workbook. The default worksheet’s default name is 

“Sheet1” and appears on the worksheet tab in the lower-left corner of the workbook window.

 By default, each workbook you create or open appears in a new Excel application window. If 

desired, you may open and then close different workbooks within a single Excel application window. If you 

close the workbook within an opened Excel application window, some of the items within the Excel 

environment still appear onscreen until you exit the Excel application window itself.

 The application window is the outer frame of the program that contains the workbooks you open or 

create. It consists of the Title Bar, the Quick Access toolbar, the Ribbon, the Formula Bar, and the Status 

Bar. Any workbooks you create or open appear within the application window. When you exit the Excel 

application or close a workbook in an Excel application window, Excel prompts you to save any changes 

made to any open workbooks before closing.

 Workbooks appear inside the application window. Each workbook contains an individual worksheet, 

the worksheet tabs, the worksheet scroll bars, and the “Previous Sheet” and “Next Sheet” buttons.

 Examine the individual elements that comprise the Excel application window and the workbooks 

within it. In addition to knowing the names of these objects and where they appear onscreen, you also need 

to know the function of each object within Excel.

Rows

Scroll Bars

Worksheet

Tab Status Bar

Columns

“Previous Sheet” 

and “Next Sheet” 

Buttons

Ribbon

Title Bar

Formula Bar

Name Box

Active Cell

Quick Access Toolbar
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Getting Acquainted with Excel

1.3- The Title Bar:

 The Title Bar in Excel for Microsoft 365 appears at the top of the application window. It shows the 

name of the workbook on which you are working. The Microsoft Search Bar appears in the center of the 

Title Bar, by default. The Quick Access toolbar appears at its left end, by default. The right end of the Title 

Bar shows a button for your current Microsoft account. You can click this button to change which account 

you use to sign into Microsoft 365.

 The next three buttons control the size of the application window. From left to right, they are 

“Minimize,” “Maximize/Restore Down,” and “Close.” Clicking the “Minimize” button sends the application 

window down to the Windows taskbar. To show it again later, click its entry in the Windows taskbar.

 Clicking the “Maximize” button enlarges the application window to fill the entire display. It also 

toggles the function of the same button to the “Restore Down” command. Clicking the “Restore Down” 

button changes the size of the window, letting you size and position it onscreen by using your mouse. When 

you click the “Restore Down” button, it also toggles back into the “Maximize” button.

 Clicking the “Close” button simply closes the Excel application window. If you have unsaved 

changes in any open workbooks, you are prompted to save those changes before the program closes.

1.4- The Ribbon:

 The primary tool available for you to use in Excel is the Ribbon. The Ribbon lets you perform all the 

commands available. The Ribbon is divided into tabs. Except for the “File” tab, which lets you access the 

backstage view of a file, you can click any tab to show button groups of commands below it. You can then 

access the commands in each button group using the buttons, boxes, or menus available in the group.

 To access advanced options for some button groups, you can click the “dialog box” launcher button 

in the lower-right corner of some button groups on the currently displayed, or “active,” tab in the Ribbon. 

Doing this then opens a dialog box of all the available options or settings for the button group.

 Also notice that you can double-click the active tab in the Ribbon to both hide and show the contents 

of the Ribbon. This can be a handy way to gain additional workspace while creating your workbook’s  

contents.

 You can click the main tabs in the Ribbon to switch the button groups that appear. The default tabs 

that appear in the Ribbon are: “File”, “Home,” “Insert,” “Page Layout,” “Formulas,” “Data,” “Review,” “View,” 

“Automate,” “Help,” and possibly “Add-Ins,” if you enabled add-ins in Excel. You can also enable the 

“Developer” tab, if using macros or code within a workbook.

 In addition to the primary tabs available in Excel, you will also see special “contextual” tabs appear 

in the Ribbon when you have a particular type of object selected in a workbook. Contextual tabs appear, for 

example, when you select either a picture, table, diagram, drawing, or chart in your workbook. The button 

groups on the contextual tabs directly relate to modifying the selected type of object. To hide the contextual 

tabs, click away from the selected object in the workbook to deselect it.

 To change the Ribbon display options, if desired, click the “Ribbon Display Options” drop-down 

arrow in the lower-right corner of the far-right button group in the Ribbon. Then select your desired Ribbon 

display choice from the drop-down menu that appears. To show Excel in full-screen mode, select the “Full-

screen mode” command. To show the Ribbon in full-screen mode, click the ellipsis mark button in the 

window’s upper-right corner.

 To only show the tabs in the Ribbon, select the “Show tabs only” command. To always show the full 

Ribbon, select the “Always show Ribbon” command. To show or hide the Quick Access toolbar, select the 

“Hide Quick Access Toolbar” or “Show Quick Access Toolbar” command.
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Getting Acquainted with Excel

1.5- The “File” Tab and Backstage View:

 Unlike other primary tabs in the Ribbon, clicking the “File” tab in the Ribbon opens a view of the file 

called the “Backstage View.” This view lets you perform all your file management. This includes functions 

like saving a file, opening an existing file, and creating a new file.

 When you click the “File” tab in the Ribbon, you no longer see the contents of the file on which you 

were working. Instead, you see the “Backstage View” of your file. The commands that appear at the left side 

of the backstage view are the available file management commands, followed by account and program 

options in a separate command section.

 Clicking a command in this list of file management commands at the left side of the backstage view 

then shows additional options for the selected command to the right in the Backstage View. You can then 

make additional selections in the new section, as needed. For example, to create a new workbook, click the 

“New” command at the left side of the backstage view. Then select the desired workbook template from 

which to create the new workbook from the template listing to the right in the backstage view. After 

completing a command in the backstage view, you will then often return to the normal working view of the 

workbook. However, if you enter the backstage view and want to exit without selecting a command, click the 

“Back” arrow button in the upper-left corner of the backstage view to return to the normal workbook view.

1.6- Scroll Bars:

 The scroll bars run both vertically and horizontally in the lower-right corner of a workbook. You can 

click the arrows at the ends of the scroll bars to scroll through the workbook in that direction. You can also 

click and drag the little gray box inside of the scroll bars to quickly scroll through the content displayed in the 

workbook, too.
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Getting Acquainted with Excel

1.7- The Quick Access Toolbar:

 The Quick Access toolbar appears above the Ribbon, by default. To place it below the Ribbon, if 

desired, click the “Customize Quick Access Toolbar” button at the right end of the toolbar. Then select the 

“Show Below the Ribbon” command from the drop-down menu that appears. To reset it to its default 

location, click the same “Customize Quick Access Toolbar” button. Then choose the “Show Above the 

Ribbon” command from the drop-down menu that appears.

 This is the only toolbar available in Excel. By default, you have buttons for quick access to the 

following commands: “AutoSave,” if saving files to OneDrive or SharePoint, “Save,” “Undo,” and “Redo 

(Repeat).” However, you can also easily add buttons to this toolbar for the functions you use most.

 One way to add a button to the Quick Access toolbar is to right-click the command button or function 

in the Ribbon which you want to add. Then choose the “Add to Quick Access Toolbar” command from the 

pop-up menu that appears. The function is then added to the Quick Access toolbar. To remove a button you 

have added to the Quick Access toolbar, right-click the button to remove in the Quick Access toolbar. Then 

select the “Remove from Quick Access Toolbar” command from the pop-up menu that appears.

 To more thoroughly customize the Quick Access toolbar, click the “Customize Quick Access 

Toolbar” button. Then click the “More Commands…” choice to open the “Excel Options” window.

 The right side of the window contains two sets of command button listings. The listing at the far-right 

side of the panel is the set of button commands currently shown in the Quick Access toolbar. The order in 

which the commands appear in this list from top to bottom is the order they appear from left to right in the 

Quick Access toolbar.

 To the left of this list is a listing of commands you can add to the Quick Access toolbar. You can 

select which functions appear in this list by selecting a command grouping to show from the “Choose 

commands from:” drop-down above the list.

 To add a command to the Quick Access toolbar from this list, click the command to add from the 

choices available in the left list. Then click the “Add>>” button to move the selected command into the Quick 

Access toolbar list to the right.

 To remove a command from the Quick Access toolbar list to the right, click it to select it, first. Then 

click the “Remove” button to remove it from the list.

 Also, you can change the order in which the buttons appear in the Quick Access toolbar by first 

selecting a command in the right-most list. Then click either the “Up” or “Down” arrow buttons to the right of 

this list. After customizing the content of the Quick Access Toolbar, click the “OK” button in the lower-right 

corner of the “Excel Options” window to save and apply your changes.

1.8- Touch Mode:

 Because of the increased use of tablets, Excel contains a mode that gives you easier access to the 

buttons and commands in the Ribbon and Quick Access toolbar. This mode is called touch mode. When 

you enter touch mode in Excel, you enlarge the Ribbon and Quick Access toolbar. You also add extra 

space around the buttons and commands in the Ribbon and Quick Access toolbar. These changes let you 

more easily access these buttons on a touch-based tablet.

 To enable touch mode, click the small drop-down arrow at the right end of the Quick Access toolbar 

to display a drop-down menu of the most commonly-used commands. Click or tap the “Touch/Mouse Mode” 

command in the drop-down menu to add that button to the Quick Access toolbar.

 To then enable or disable touch mode in Excel, click or tap the “Touch/Mouse Mode” button in the 

Quick Access toolbar. From the drop-down menu that then appears, select the mode to use: “Mouse” or
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Getting Acquainted with Excel

1.8- Touch Mode- (cont’d.):

“Touch.” When “Touch” mode is enabled, the buttons in the Ribbon and Quick Access toolbar are larger 

and have more space surrounding them onscreen. You can select the “Mouse” choice to toggle touch mode 

off, restoring the default size of the buttons onscreen.

1.9- The Formula Bar:

 The Formula Bar appears underneath the Ribbon. At its left end is the “Name Box,” which displays 

the address of the currently selected cell in your workbook. To the right of that is the “Insert Function” 

button, which looks like the function (fx) sign. The large bar to the right of that button is where you can see, 

edit or create a formula to enter into the currently selected cell in the workbook.

 If you want to edit or change formulas after creating them, they appear here for editing. Later on, this 

feature becomes invaluable to you. For now, just remember that you should look into this bar to see the 

actual contents of cells that contain formulas, versus looking at the answers to those formulas that appear 

in the actual workbook cells.

1.10- The Workbook Window:

 The workbook window is the window in which you will perform almost all your work. You enter data 

into the worksheets within the workbook window. The names of the worksheets in a workbook appear on 

tabs in the lower-left corner of the workbook. A workbook stores information much like a database table 

does. A single worksheet in an Excel workbook is arranged as a grid that contains 16,384 columns and 

1,048,576 rows. The first 26 columns are labeled A through Z. After that, they are labeled AA through AZ, 

then AAA through XFD. The rows are simply sequentially numbered from 1 through 1,048,576.

 The intersection of a column and a row in a worksheet is called a cell. Cells are where you enter 

information. They are referenced by the intersection of their column letter and row number locations within 

the worksheet, using an identification known as a “cell address.” For instance, the first cell in the upper-left 

corner is called cell “A1,” because it is in column A at row 1. To the right of that cell is cell “B1” because it is 

in column B, row 1. To refer to a specific cell in a worksheet, just combine its column letter with its row 

number.

 You can only enter data into the currently selected cell within a worksheet, which is also called the 

“active” cell. You can tell which cell is the active cell because it has a border around it and its cell address 

appears in the “Name” box in the Formula Bar. The column and row headings for the column and row in 

which the active cell appears are also highlighted a slightly darker grey. You can only have one active cell 

available for data entry at a time. Make sure you leave the cell after performing data entry by moving the 

cursor out of the cell using keystrokes, or by clicking into a different cell, to set the data in the cell and 

continue data entry in the workbook.

 Although you can scroll throughout the whole worksheet, you can only enter data into the currently 

selected cell. So, even if you’ve scrolled the view of the worksheet one hundred columns to the right, if your 

active cell is “A1” that’s where your data entry will occur when you type.

 You can also select or reference multiple cells to manipulate the information contained inside of 

them. A selection of multiple cells or a reference to multiple cells is called a cell range. For instance, you 

can select the cells from “A1” through “A10” and then add their values together. We will look at selecting, 

referencing, and manipulating cell ranges later in this tutorial.

Sam
ple

 - f
or 

ev
alu

ati
on

 pu
rpo

se
s o

nly
!



14Mastering Excel Made Easy©TeachUcomp, Inc.

Getting Acquainted with Excel

1.11- The Status Bar:

 At the bottom of the application window is the Status Bar. This tool provides you with information 

about your workbook. One of the most important status indicators in Excel is the “Cell Mode” status 

indicator that appears at the far-left end of the Status Bar. There are three main cell modes you will see: 

“Ready,” “Edit,” or “Enter.”

 If the word “Ready” appears, Excel is ready to do just about anything. This is the cell mode you want 

to be in before you begin a task. The next mode is “Edit.” If you are in “Edit” mode, you currently have a cell 

you are editing, but you have not yet moved from the cell to set its data entry. Many commands are 

unavailable to you when in “Edit” mode. The last mode is “Enter.” This is much like “Edit,” but is shown 

when entering new information into a blank cell. Also, most commands are unavailable to you until you 

finish data entry and return to “Ready” mode.

 In addition to the “Cell Mode” status indicator, other indicators and tools, like the workbook’s “Views 

Shortcuts” and the “Zoom Slider,” also appear at the right end of the Status Bar. You can choose which 

statuses to show or hide in the Status Bar. To see which statuses are currently shown or hidden in the 

Status Bar, right-click your mouse anywhere in the Status Bar to view the “Customize Status Bar” panel. 

This panel shows a listing of the available tools and statuses you can show or hide in the Status Bar. Any 

listed objects that appear with a check to the left of their names already appear in the Status Bar. Objects 

without a check to the left of their names in this list do not appear in the Status Bar. You can click the name 

of any object in this list to toggle its display in the Status Bar on or off.

1.12- The Workbook View Buttons:

 The workbook view buttons are a group of three buttons that appear towards the lower-right corner 

of the application in the Status Bar. You can click these buttons to change the working view of your 

workbook. By default, Excel opens in “Normal” view, which is the view most commonly-used for standard 

workbook creation. Unless otherwise specified by a lesson, you can assume the workbook view referenced 

by the lessons of this tutorial refers to the “Normal” view.

 However, you can switch between the different views of a workbook, as needed. Each has its own 

use within the program. The different document views are: “Normal,” “Page Layout,” and “Page Break 

Preview.” The “Page Layout” view lets you add header and footer information and see how your workbook 

appears when printed. The “Page Break Preview” lets you easily set page breaks for workbooks before 

printing them.

 You can also select the “View” tab in the Ribbon and then click the command buttons in the 

“Workbook Views” button group to switch between workbook views. Doing this is just an alternative way of 

switching between the workbook views. Use whichever method you prefer.

1.13- The Zoom Slider:

 The Zoom slider appears in the Status Bar towards the lower-right corner of the application window. 

You use it to change the workbook’s magnification level. This does not modify the workbook at all. It only 

changes your perception of how close or far away the workbook’s contents appear onscreen.

 To change the magnification level using the Zoom slider, click and drag the Zoom slider left or right. 

Sliding it to the left, towards the minus symbol, shrinks the magnification level. The magnification level 

appears as a percentage next to the zoom slider. Clicking and dragging the slider to the right, or towards 

the plus sign, increases the magnification level.
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Getting Acquainted with Excel

1.13- The Zoom Slider- (cont’d.):

 You can also change the magnification using the settings in the “Zoom” dialog box. To access this 

dialog box, click the zoom magnification level in the Status Bar. Alternatively, click the “View” tab in the 

Ribbon. Then click the “Zoom” button in the “Zoom” button group. Also, note the other common 

magnification levels in the “Zoom” button group in the Ribbon. You can also click these buttons to change 

the magnification.

 In the “Zoom” dialog box, select the desired zoom level by choosing an option from the 

“Magnification” section. Then click the “OK” button to apply the magnification level to the workbook view.

1.14- The Mini Toolbar:

 When you select text in a cell and hold your mouse pointer over it, a small dimmed-out toolbar 

appears next to the selection. This is the Mini toolbar. You can roll your mouse pointer over the faded-out 

toolbar to make it appear solid. You can then select from the many buttons that appear in the Mini toolbar to 

quickly apply commonly-used formatting to the selection.

1.15- Keyboard Shortcuts:

 A keyboard shortcut lets you press a combination of keyboard characters to execute a command, 

instead of clicking a button in the Ribbon or the Quick Access toolbar. While you may never use them, many 

users find it tiresome to reach for their mouse to execute a command function. These users may favor using 

keyboard shortcuts, instead, as they let them perform many command functions while keeping their hands 

on the keyboard.

 Keyboard shortcuts typically involve holding down either the “Ctrl” or “Alt” key on your keyboard and 

then entering another keystroke or set of keystrokes. Then release the “Ctrl” or “Alt” key. You can see any 

available “Ctrl”-key keyboard shortcuts in the small pop-up windows that appear when you hold your mouse 

pointer over any command function in the Ribbon. However, not every command function has a 

corresponding “Ctrl”-key keyboard shortcut. In these cases, you can use the “Alt” key to enable the key 

badge system in Excel. You can then use the key badge system to enter a sequence of keystrokes. Let’s 

look at how to use the key badge system in Excel.

 First, press the “Alt” key on your keyboard to show a set of key badges next to the objects in the 

Ribbon and Quick Access toolbar. Then press the key on your keyboard that corresponds to the command 

function to show or execute. Continue pressing the corresponding key badges that appear until you press 

the key badge for the final command function you want to execute.

 If you happen upon a drop-down menu when entering key badges or your key badge work opens a 

dialog box, don’t worry. You can execute a command in a dialog box or in a drop-down by looking to see if 

the command function to execute has an underlined letter in its name. If it does, press the key on your 

keyboard that corresponds to the underlined letter. That is the same thing as pressing a corresponding 

keyboard key when you see a key badge.Sam
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ACTIONS-

Getting Acquainted with Excel

THE EXCEL ENVIRONMENT:

1. A workbook is the default file type in Excel.

2. A workbook can contain multiple worksheets that store and manipulate data in columns and rows.

3. In a new, blank workbook, the default worksheet’s default name is “Sheet1” and appears on the 

worksheet tab in the lower-left corner of the workbook window.

4. By default, each workbook you create or open appears in a new Excel application window.

5. If desired, you may open and then close different workbooks within a single Excel application window.

6. The application window is the outer frame of the program that contains the workbooks you open or 

create. It consists of the Title Bar, the Quick Access toolbar, the Ribbon, the Formula Bar, and the 

Status Bar.

7. Any workbooks you create or open appear within the application window.

8. When you exit the Excel application or close a workbook in an Excel application window, Excel prompts 

you to save any changes made to any open workbooks before closing.

9. Each workbook contains an individual worksheet, the worksheet tabs, the worksheet scroll bars, 

and the “Previous Sheet” and “Next Sheet” buttons.

THE TITLE BAR:

1. The Title Bar in Excel for Microsoft 365 appears at the top of the application window and shows the 

name of the workbook on which you are working.

2. The Microsoft Search Bar appears in the center of the Title Bar, by default.

3. The Quick Access toolbar appears at its left end, by default.

4. The right end of the Title Bar shows a button for your current Microsoft account, which you can click to 

change which account you use to sign into Microsoft 365.

5. The next three buttons to the right control the size of the application window.

6. To send the application window down to the Windows taskbar, click the “Minimize” button.

7. To show it again later, click its entry in the Windows taskbar.

8. To enlarge the application window to fill the entire display, click the “Maximize” button, which also 

toggles the function of the same button to the “Restore Down” command.

9. To reduce the size of the window to one that you can size and position onscreen using your 

mouse, click the “Restore Down” button, it also toggles the button back into the “Maximize” button.

10. To close the Excel application window, click the “Close” button.

THE RIBBON:

1. The Ribbon is divided into tabs. Except for the “File” tab, which lets you access the backstage view of a 

file, you can click any tab to show button groups of commands below it. You can then access the 

commands in each button group using the buttons, boxes, or menus available in the group.

2. To access advanced options for some button groups, click the “dialog box” launcher button in the 

lower-right corner of some button groups on the currently displayed, or “active,” tab in the Ribbon to 

show a dialog box of all the available options or settings for the button group.

3. To both hide and show the contents of the Ribbon, double-click the active tab in the Ribbon.

4. The default tabs in the Ribbon are: “File”, “Home,” “Insert,” “Page Layout,” “Formulas,” “Data,” “Review,” 

“View,” “Automate,” “Help,” and possibly “Add-Ins,” if you enabled add-ins in Excel.

 (cont’d.)
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ACTIONS-

Getting Acquainted with Excel

THE RIBBON- (CONT’D.):

5. You can also enable the “Developer” tab, if using macros or code within a workbook.

6. Special contextual tabs also appear in the Ribbon if you select an object in a workbook. The button 

groups on contextual tabs directly relate to modifying the selected type of object.

7. To hide the contextual tabs, click away from the selected object in the workbook to deselect it.

8. To change the Ribbon display options, if desired, click the “Ribbon Display Options” drop-down 

arrow in the lower-right corner of the far-right button group in the Ribbon.

9. Then select your desired Ribbon display choice from the drop-down menu that appears.

THE “FILE” TAB AND BACKSTAGE VIEW:

1. To open a view of the file called the “Backstage View,” click the “File” tab in the Ribbon.

2. In the backstage view of your file, the commands shown at the left side of the view are the available file 

management commands, followed by account and program options in a separate command section.

3. When you click on a command in the far-left section of commands, you will see additional options for the 

selected command appear to the right within the Backstage View.

4. Make additional selections in the new section, as needed.

THE SCROLL BARS:

1. The scroll bars can appear both vertically and horizontally along the right and bottom sides of your 

document window. They have arrows at each end that point in the direction in which they will scroll the 

workbook window when you click them.

2. To move through the workbook, click the arrows at the ends of the scroll bars.

3. To move through the workbook more rapidly, click and drag the box inside the scroll bars.

THE QUICK ACCESS TOOLBAR:

1. To place the Quick Access Toolbar below the Ribbon, click the “Customize Quick Access Toolbar” 

button at the right end of the toolbar and then select the “Show Below the Ribbon” command from the 

drop-down menu that appears.

2. To reset it to its default location, click the same “Customize Quick Access Toolbar” button and then 

choose the “Show Above the Ribbon” command from the drop-down menu that appears.

3. To add a button to the Quick Access toolbar, right-click any command button or function in the 

Ribbon and choose the “Add to Quick Access Toolbar” command from the pop-up menu that appears.

4. To remove a button you added to the Quick Access toolbar, right-click the button in the Quick 

Access toolbar that you wish to remove and then choose the “Remove from Quick Access Toolbar” 

command from the pop-up menu that appears.

5. To fully customize the Quick Access toolbar, click the “Customize Quick Access Toolbar” button and 

then click the “More Commands…” choice in the drop-down menu to open the “Excel Options” window.

6. At the right side of the window are two sets of command button listings. The listing at the far-right is the 

set of button commands currently shown in the Quick Access toolbar. To the left of that list is a listing of 

commands you can add to the Quick Access toolbar.

 (cont’d.)
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ACTIONS-

Getting Acquainted with Excel

THE QUICK ACCESS TOOLBAR- (CONT’D.):

7. To select which functions appear in the list, select a command grouping to display from the “Choose 

commands from:” drop-down above the list.

8. To add a command to the Quick Access toolbar from this list, click the command to add from the 

choices available in the left list.

9. Click the “Add>>” button to move the selected command into the Quick Access toolbar list to the right.

10. To remove a command from the Quick Access toolbar list to the right, click it to select it, and then 

click the “Remove” button.

11. To change the order in which the buttons appear in the Quick Access toolbar, select a command 

in the right-most list and then click either the “Up” or “Down” arrow buttons to the right of the list.

12. To save and apply your changes when you have finished customizing the content of the Quick 

Access Toolbar, click the “OK” button in the lower-right corner of the “Excel Options” window.

TOUCH MODE:

1. To enable the “Touch/Mouse Mode” button, click the small drop-down arrow at the right end of the 

Quick Access toolbar to display a listing of the most commonly-used commands.

2. Click or tap the “Touch/Mouse Mode” command in the drop-down menu to add that button to the Quick 

Access toolbar.

3. To enable or disable touch mode, click or tap the “Touch/Mouse Mode” button within the Quick 

Access toolbar.

4. Select the mode you prefer to use from the drop-down menu that appears: “Mouse” or “Touch.”

5. When “Touch” mode is enabled the buttons within the Ribbon and Quick Access toolbar appear larger 

and with more space surrounding them onscreen.

6. You can select the “Mouse” choice to toggle touch mode off, restoring the default size of the buttons 

onscreen.

THE FORMULA BAR:

1. The Formula Bar appears underneath the Ribbon.

2. The “Name Box” at its left end shows the address of the currently selected cell in your workbook.

3. To the right of that is the “Insert Function” button, which looks like the function (fx) sign.

4. The large bar to the right of that button is where you can see, edit or create a formula to enter into the 

currently selected cell in the workbook.

5. If you want to edit or change formulas after creating them, they appear here for editing. You should look 

into this bar to see the actual contents of cells that contain formulas, versus looking at the answers to 

those formulas that appear in the actual workbook cells.

THE WORKBOOK WINDOW:

1. You enter data into the worksheets within the workbook window.

2. The names of the worksheets in a workbook appear on tabs in the lower-left corner of the workbook.

3. The intersection of a column and a row in a worksheet is called a cell.

 (cont’d.)
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ACTIONS-

Getting Acquainted with Excel

THE WORKBOOK WINDOW- (CONT’D.):

4. Cells are where you enter information.

5. Cells are referenced by the intersection of their column letter and row number locations within the 

worksheet, using an identification known as a cell address.

6. You can only enter data into the currently selected cell within a worksheet, which is also called the 

active cell.

7. The active cell has a border around it and its cell address appears in the “Name” box in the Formula 

Bar.

8. The column and row headings for the column and row in which the active cell appears are also 

highlighted a slightly darker grey.

9. You can only have one active cell available for data entry at a time.

10. Make sure you leave the cell after performing data entry by moving the cursor out of the cell using 

keystrokes, or by clicking into a different cell, to set the data in the cell and continue data entry in the 

workbook.

11. A selection of multiple cells or a reference to multiple cells is called a cell range.

THE STATUS BAR:

1. At the bottom of the application window is a long, thin, horizontal bar called the Status Bar that shows 

statuses that are capable of being monitored in Excel, such as the cell mode and the magnification 

level.

2. To choose which statuses you want to show or hide in the Status Bar, right-click your mouse 

anywhere in the Status Bar to view the “Customize Status Bar” panel, which shows a listing of the 

available tools and statuses you can show or hide in the Status Bar.

3. Any listed objects that appear with a check to the left of their names are being shown in the Status Bar.

4. Objects without a check to the left of their names in this list are not being shown in the Status Bar.

5. To toggle their display on or off, click the name of any object in this list.

THE WORKBOOK VIEW BUTTONS:

1. To change the workbook view, click the desired workbook view button towards the lower-right corner 

of the application in the Status Bar: “Normal,” “Page Layout,” or “Page Break Preview.”

2. Alternatively, to switch between the views of a workbook, select the “View” tab in the Ribbon and 

then click the command buttons that appear within the “Workbook Views” button group.

THE ZOOM SLIDER:

1. To change the magnification level by using the Zoom slider, click and drag the Zoom slider.

2. To decrease the magnification level, click and drag the slider left, towards the minus symbol.

3. To increase the magnification level, click and drag the slider to the right, or towards the plus sign,.

4. The current magnification level appears as a percentage next to the zoom slider.

 (cont’d.)
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THE ZOOM SLIDER- (CONT’D.):

5. To change the magnification using the “Zoom” dialog box, open the dialog box by clicking the 

actual zoom magnification level shown in the Status Bar or by clicking the “View” tab in the Ribbon and 

then clicking the “Zoom” button in the “Zoom” button group.

6. In the “Zoom” dialog box, select the desired zoom level by choosing an option from the “Magnification” 

section.

7. Click the “OK” button to apply the selected magnification level to the workbook view.

8. To change the magnification to a commonly selected magnification level, click the button for the 

desired zoom level shown in the “Zoom” button group in the Ribbon.

THE MINI TOOLBAR:

1. When you select text within a cell and hold your mouse pointer over it, you will see a small dimmed-out 

toolbar appear next to the selection.

2. To make it appear solid, roll your mouse pointer over the faded-out toolbar.

3. To apply quick formatting to the selection, select from the many buttons that appear in the Mini 

toolbar.

KEYBOARD SHORTCUTS:

1. To enter a keyboard shortcut that begins with the “Ctrl” key, press and hold down the “Ctrl” key.

2. Then simultaneously press any other keys listed in the “Ctrl” key shortcut once.

3. Then release the “Ctrl” key.

4. To enable the key tip badges, press the “Alt” key.

5. Press the key on your keyboard that corresponds to the key tip badge that you wish to show or execute.

6. Continue to press the corresponding key tip badge until you reach the final command you wish to 

execute.

7. If you see a command in a drop-down or dialog box that has an underlined letter in its name 

while using the key badge system, you can press the corresponding key for the underlined letter on 

your keyboard to execute it, just as if the underlined letter were a key tip badge.
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EXERCISES-

Getting Acquainted with Excel
Purpose:

To find the basic objects in the Excel application. 

Exercises:

1. Open your Excel application.

2. Find the Zoom Slider.

3. Find the Quick Access toolbar.

4. Find the Ribbon.

5. Locate the Status Bar at the bottom of the screen.

6. Exit the Excel application.
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